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EXECUTIVE SUMMARY

Introduction

Objective

Audience

Datacenters have traditionally separated compute and storage resources. While
this made sense for some, it also posed challenges in the areas of performance,
scalability, and cost. A more modern approach brings these resources together into
hyperconverged solutions, in which compute and storage share a chassis.

The Dell XC630-10 system powered by Intel processors E5-2630 v3 and using
Nutanix® software is one such hyperconverged solution. Its unique architecture
combines 1U form factor Dell XC630-10 appliances, Intel processors, onboard storage,
and Nutanix cluster software in a flexible and scalable package that uses minimal
datacenter space, which has the potential to lower power and cooling costs.

In the Principled Technologies datacenter, we set up the Dell and Intel
hyperconverged solution on a VMware® vSphere® (ESXi™) 6.0 cluster. To see how well
the solution functioned, we tested a mixed workload, including Microsoft® Exchange
Server, Microsoft SQL Server®, file and print activity, and disk activity simulating a web
server—a workload that reflects what a small to medium-sized company might do on a
daily basis.

In this reference architecture, we present our findings and offer a guide and

best practices for implementing this solution in your datacenter.

This reference architecture shows how the Dell XC630-10 system powered by
the Intel Xeon processor E5-2630 v3 and using Nutanix software functioned well with
mixed workloads when configured as a VMware vSphere cluster. It also provides best
practices and a configuration guide for setting up this Dell and Intel solution running

VMware vSphere in the datacenter of a medium-sized business.

We have targeted this reference architecture to an audience of IT
administrators at small to medium businesses with several hundred employees. Note
that we do not describe every possible configuration of each component in the Dell and

Intel solution.
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HARDWARE SOLUTIONS
About the Dell XC630 Web-Scale Converged Appliance

Dell XC Series Web-Scale Converged Appliances, powered by Nutanix software,
let you consolidate compute and storage into a single chassis. According to Dell, these
appliances install quickly, integrate easily into any datacenter, and can be deployed for
multiple virtualized workloads including desktop virtualization, database, and private
cloud projects. They let your enterprise grow incrementally with pay-as-you-grow,
scale-out expansion; increase capacity and performance one node at a time; and meet
future needs without over-provisioning.

The Dell XC630-10 is a compact 1U compute/storage node, making it attractive
to companies with limited rack space and those deploying VDI and other virtualized
workloads. It has 10 drive slots that can be populated with up to four SSDs (two SSDs
being mandatory) and up to eight HDDs.

Learn more at www.dell.com/us/business/p/dell-xc-series/pd.

About the Dell Networking S4048-ON top-of-rack switch
The Dell Networking S4048-ON 10/40 GbE top-of-rack Open Networking switch,

Dell’s latest datacenter networking solution, is built to optimize performance, efficiency,

flexibility, and availability in the modern datacenter. According to Dell, it offers a range

of benefits, including:

= Low latency. To deliver the strongest performance, the S4048-ON leverages a non-
blocking architecture to deliver line-rate L2 and L3 forwarding — ideal for use in high-
speed, business-sensitive deployments.

= High density. The S4048-ON takes up only a single rack unit but offers 48 dual-speed
1/10GbE (SFP+) ports and six 40GbE uplinks. In addition to saving space, this specific
level of density may simplify your migration to 40Gbps in the core of the datacenter.

=  Flexibility in the datacenter. The S4048-ON includes several architectural features
that can help you keep your datacenter running smoothly. Its I/O panel to PSU or
PSU to I/0 panel airflow can give you more flexibility with your hot/cold aisle
arrangements, and it offers redundant, hot-swappable power supplies and fans to
reduce the cost of datacenter maintenance.

Learn more at i.dell.com/sites/doccontent/shared-content/data-
sheets/en/Documents/FY16Q1 201 Dell Networking S4048-
ON SpecSheet 040215.pdf.
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SOFTWARE SOLUTIONS
Operating systems
About VMware vSphere (ESXi) 6.0
VMware vSphere (ESXi) 6.0 is the latest release of this leading server
virtualization platform with management for virtual datacenters. This release includes
improvements in the following areas:
e Compute. Increased scalability, expanded support, improved graphics,
Instant Clone* Technology.
e Storage. vSphere Virtual Volumes, Storage Policy-Based Management
(SPBM).
e Network. Network I0 control, multicast snooping, multiple TCP/IP Stack
for vMotion®.
e Availability. vMotion enhancements, Replication-Assisted vMotion,
fault tolerance (up to four vCPUs)
e Management. Content Library, cross-vCenter™ Clone and Migration,
enhanced user interface.
Learn more at www.vmware.com/products/vsphere#tsthash.3900D5CI.dpuf
About Nutanix 0S 4.1
According to Nutanix, the Nutanix Operating System, NOS 4.1, offers rich

enterprise capabilities to meet the needs of the most demanding applications and
critical infrastructure requirements in the datacenter.

The 4.1 release includes the following new capabilities:

e Metro Availability, which provides continuous data availability for business-
critical applications during planned maintenance or unplanned disasters
that affect entire sites.

e Cloud Connect, which seamlessly integrates public cloud services, such as
Amazon Web Services (AWS), with Nutanix-powered private cloud
environments.

e Encryption Support, encrypting user and application data to a level of FIPS
140-2 Level 2 compliance.

e Simplified Hypervisor Upgrade, with support for VMware ESXi, Microsoft
Hyper-V®, and KVM.

e Security/STIG Enhancements

Learn more at www.nutanix.com/2015/01/29/announcing-general-availability-

nutanix-operating-system-4-1/.
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SOLUTION DESIGN AND CONFIGURATION

Overview of the scope of this guide

Before you begin

Assumptions of this guide

In this guide, we walk through the various aspects of setting up a
working Nutanix cluster on a three-node Dell XC630 appliance configuration. We
cover the network setup, including cabling, switch configurations, and VLAN
tagging; initial cluster creation for Nutanix and vSphere, and cluster storage
configuration for a three-node cluster of Dell XC630-10 appliances. We will also

highlight best practices as appropriate.

In preparation for setting up your Nutanix environment on VMware
with XC630 hosts, you will need one IP address available for the cluster’s IP
address and at least three IP addresses per host: one each for the host’s CVM,
the host’s management, and the host’s IPMI interface. In our environment, we
used VLAN tagging to keep the IPMI network separate from the CVM traffic, but
a flat network could also be set up to avoid our more complex network design.
The IPMI interfaces are required for successful cluster deployment, even though
their reachability does not affect the normal functioning of the Nutanix cluster
post-install. Also, note that if your IPMI interfaces are not configured with
routable IP addresses, some support and management functionality could
potentially be impacted.

We assume in this guide that each Dell XC630 appliance has had ESXi 6.0
pre-installed and the Nutanix Phoenix flashing process performed already
(Phoenix takes care of configuring disks, networking, and Nutanix Controller VM
creation). We also assume the administrator following this guide has an existing
vCenter server or appliance, DNS server, and gateway in his or her environment.
We assume that before beginning the methodology steps, you have configured
the iDRAC/IPMI interface on each host with an IP address and subnet mask, and
provided them with the existing DNS and gateway addresses.

From a networking perspective, we designed this guide to be
representative of a real-world enterprise environment, rather than a basic flat
network. Though we cover setup for a more complex network infrastructure,
including redundant switches, VLAN tagging to segregate traffic, and virtual link
trunking, Nutanix can be deployed on a vSphere environment in a similar

fashion on a simpler network.
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Introduction to Nutanix architecture
Nutanix uses a hyperconverged infrastructure to provide a tiered

storage solution to VMs. Every host in a Nutanix cluster houses a Controller VM
(CVM), which runs the Nutanix software and handles all storage 1/0 operations
for the host’s hypervisor and all the VMs residing on that host. In the case of
ESXi, the host server’s SSDs and hard disk drives are directly passed through to
the CVM for management.

Administrators can create a storage container from the Nutanix cluster’s
disks to be used as storage for all the cluster’s hosted VMs. Nutanix cluster
nodes typically have a small number of fast but low-capacity SSDs and a larger
number of slower but high-capacity HDDs. Nutanix’s storage
tiering/prioritization works to move data to the most appropriate location
(either local SSDs, cluster SSDs, or HDDs) based on availability of fast storage
and how frequently the data in question is accessed. By converging compute
and storage resources into single appliance nodes, scaling Nutanix clusters out is
easy and flexible.

Solution architecture and diagrams

Every Dell XC630 appliance in a Nutanix cluster has the same basic
configuration: a tier of SSD-based flash storage, a tier of hard disk drives,
compute resources in the form of two Intel Xeon processors E5-2630 v3, and
192 GB of DDR4 RAM. At the hypervisor layer, each host runs VMware ESXi,
which hosts a single Nutanix Controller VM, and as many other VMs as you

configure for your environment (see Figure 1).
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Controller
VM

Flash
storage

Hard disk

storage AR

Dell XC630 host

Figure 1: The structure of each node in our Nutanix cluster.

Once the cluster has been created, the flash and hard disk storage resources
from each node are logically grouped and defined through software as a storage pool.
From there, a container is created and used for housing the virtual hard disks and virtual
machine configuration files for your environment. Although we did not use these
features, Nutanix offers storage efficiency technologies such as deduplication, which
removes duplicate data to increase the effective amount of storage resources available
and accelerate performance, as well as thin provisioning, which allows a LUN to be
created without allocating physical storage space that would go unused initially (more
physical space is used as the actual space fills up). For more information on
deduplication as provided by Nutanix, go to

www.nutanix.com/products/features/enterprise-storage/deduplication/. Figure 2

shows how the storage for the three-node cluster we tested was configured.

Dell XC630-10 Nutanix on VMware ESXi reference architecture A Principled Technologies reference architecture 9


http://www.nutanix.com/products/features/enterprise-storage/deduplication/

Datastore

Flash-1 Flash-2 Flash-3

HDD-1 HDD-2 HDD-3

Figure 2: The Nutanix storage cluster’s container is comprised of the flash and hard disk
storage from each host.

Our environment used redundant 10 Gbps Dell Networking S4048-ON switches
for cluster/VM traffic and vMotion, and redundant 1 Gbps Dell Networking N2024
switches for IPMI traffic. We used VLAN tagging to segregate the public traffic from the
vMotion traffic and Fault Tolerance traffic, Dell Virtual Link Trunking (VLT) between the
S4048-0ON switches, and 1 Gbps links between the S4048-ON switches and the N2024
switches (see Figure 3).

Dell Networking Pol
N2024 switch

5 S T L s VLT peer links |Lele! e e e e
Dell Networking Dell Networking
> Access 100 (IPM1) S4048-ON switch S4048-ON switch

VLAN

10- Public (data)
100- Private (data)
Trunk 101- vMotion
10 102- Fault Tolerance
100 (untagged)
101 5
102 [ 40Gbps
¥ 10Gbps
I 1Gbps

Dell XC630 appliances

Figure 3: The network configuration for the Nutanix cluster we tested on Dell XC630 appliances.
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The Dell XC630 is configured (by the Phoenix flashing process) with a NIC team
created from the two 10Gb SFP ports on the Intel X520/i350 network daughter card.
Two virtual switches come preconfigured as well: one for traffic between the host and
the Nutanix CVM, and one for Nutanix cluster, vSphere management, and VM traffic.

We will later create VMkernel ports on the management switch for vMotion traffic and

-
(unused) (unused)

Fault Tolerance traffic (see Figure 4).

Management

S Fault
network vMotion-if tolerance-if VM Network
(VLAN 100, untagged) (VLAN 101) (VLAN 102) (VLAN 100, untagged)

vSwitch0 vSwitchNutanix

VIT:S-IS-:':‘-

B VMkernelport I Virtual Machine Port group

Figure 4: The structure of each XC630 host’s NIC team, formed from the two 10 Gbps ports, and
their virtual switches and VMkernel ports and port groups. Note that the 1 Gbps ports are
unused.
Creating the Nutanix cluster
1. Perform the following on each of the Controller VMs to configure their IP addresses:

a. Login with the default admin credentials.

b. Using vi, edit /etc/sysconfig/network-scripts/ifcfg-eth0, setting
BOOTPROTO=static, IPADDR=XX.XX.XX.XX,
NETMASK=YY.YY.YY.YY, and GATEWAY=Z%%7.%%.%% .77, using
appropriate values for the IP address, subnet mask, and gateway.
Save and close the file.

c. Using vi, edit /etc/resolv.conf. Add a new line of nameserver
XX .XX.XX.XX, using an appropriate IP address for your
environment’s DNS server.

d. Restart network services with /etc/init.d/network
restart.

2. Onthe Windows® 7 management system, be sure that Mozilla® Firefox® and
Bonjour® (which is included with iTunes® or downloadable from
support.apple.com/kb/DL999) are installed.
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3. Determine the IPv6 service name for one of the Dell XC630 nodes that will be added
to the cluster. IPv6 service names are uniquely generated at the factory and have
the following form (note the final period): NTNX-system_service_tag-node_location-
CVM.local. On the front left side of the system is a slide-out label that contains the
system_service_tag (for example, B57PW12). The node_location is A for one-node
blocks.

4. Inthe Windows 7 management system, launch Mozilla Firefox, and in the URL bar,
enterhttp://cvm ipvé6 addr:2100/cluster init.html, replacing
cvm ipvé addr with the IPv6 service name determined in step 2. For example,

the URL we accessed was http://NTNX-2PSNS52-A~-
CVM.local.:2100/cluster init.html

Note: Be careful to include the period after the word 1ocal in the URL.

| Nutanix Cluster Configuration x \ + == I[&]

hittp://ntnx-2psns52-a-cvmulocal. 2100/ cluster_init.htr c wB O3 A

CLUSTER CONFIGURATION

Cluster Name

NutanixCluster]

Cluster External IP

192168.0.100

Cluster Max Redundancy Facto

2
CVM DNS Servers
192168.0.10
CVM NTP Servers

192168.0.10

Figure 5: Providing a cluster name, external IP, CVM DNS server, and CVM NTP server.

5. Inthe Cluster Name field, provide an appropriate name (of 15 characters or fewer)
for your Nutanix Cluster.

6. Inthe Cluster External IP field, provide an appropriate IP address for your Nutanix
Cluster. This IP can be used to access the web console and nCLI once the cluster is

created.
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7. Leave the Cluster Max Redundancy Factor at 2, because we are using only three
nodes. A cluster must have at least five nodes to use a redundancy factor of 3, but
that configuration is beyond the scope of this guide.

8. Provide the IP address(es) of the Active Directory® domain controller(s) in the CVM
DNS Servers and CVM NTP Servers fields.

ya S
| Nutsnix Cluster Configuration % | -+ = R
€ http://ntnx-2psls52-a-cvm.local 2100/ cluster_init.html a Search e U 3 & 0 =

—A

CVM DNS Servers:

192168.0.10

CVM NTP Servers

192168.010

Hypervisor DNS Servers:
192168.010, 8888

Hypervisor NTP Servers:
192168.010, pool.ntp.org

m

Cluster-wide Network settings:

Controller Hypervisor IPmI
Subnet Mask 2552552540 2552552540 2552552540
Default
192168.01 192168.01 192168.01
Gateway

Figure 6: Providing the appropriate subnet masks and default gateways in the Cluster-wide Network
settings.

9. Provide the IP address(es) of the Active Directory domain controller(s), and in the
Hypervisor DNS Servers field, enter 8.8.8.8

10. Provide the IP address(es) of the Active Directory domain controller(s), and in the
Hypervisor NTP Servers field, enter pool .ntp.org

11. Provide the subnet masks and default gateways for each Controller, Hypervisor, and

IPMI into the Cluster-wide Network Settings table, if they are not already populated.
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/Nutanix Cluster Configuration X\+ li]@@
@D http://ntnx-2psns52-a-cvm.local.: 2100/ cluster_init.html C || Q Search B U 3 A

—‘

Discovered nodes:

Select Node Controller IP Hypervisor IP IPMI IP
] 2PSNS52/A
2PSLS52/A

2PSMS52/A

m

Log Messages:

Figure 7: If IPv6 link-local connectivity is working properly, your nodes should appear in the list of Discovered nodes.

12. Check the box next to each node that you want to add to the cluster.
13. Provide an appropriate IP address for all the components in the cluster, if the values
are not already populated. The discovered nodes are not listed in a particular order,

so be sure to assign the intended IP addresses to each node.
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| /Nutanix Cluster Configuration x\+

fo ]l ==

& http://ntnx-2psns52-a-cvm.local.:2100/ cluster_init.html

Discovered nodes:

aQ

Q Search ﬁ E ‘ ﬁ 9

Select Node Controller IP Hypervisor IP IPMI IP
@  2PSNS52/Aa | 192168.0.23 192168.013 192168.0.53
) 2PSLS52/A  192168.0.21 192168.011 192168.0.51
2PSMS52/A | 192168.0.22 192168.012 192168.0.52

Log Messages:

m

Figure 8: Provide IP addresses for the Controller, Hypervisor, and IPMI for each discovered node.

14. When you are ready to create the cluster, click Create.

15. Wait until the Log Messages section of the page indicates that the cluster has been

successfully configured. The cluster starts automatically after creation succeeds.
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' Nutanix Cluster Configuration x + | = ” & |[£_h]

ntnx-2psns52-a-cvm.local.:2100/ cluster_init.htr C ﬁ B 9 3 # (] =

m

Figure 9: Log Messages output indicating successful creation of the Nutanix cluster.

16. Log onto any Controller VM with SSH.
17. Verify that all services are up on all Controller VMs by entering the command

cluster status.

CvM: 192.168.0.21 Up
Zeus UP [8214, 8239, 8240, 8242, 8289, 8303]
Scavenger UP [10441, 10466, 10467, 10504]
SSLTerminator UP [10552, 10579, 10580, 10693]
Acropolis UP [10589, 10636, 10637, 13430]
Medusa UP [12027, 12055, 12056, 12078,
DynamicRingChanger UP [12415, 12444, 12445, 12559]
Pithos UP [12432, 12471, 12472, 12573]
Stargate UP [12466, 12500, 12501, 12717,
Cerebro  UP [12502, 12531, 12532, 12719]
Chronos UP [12520, 12557, 12558, 12682]
Curator UP [12556, 12598, 12599, 12732]
Prism UP [12596, 12628, 12629, 12699, 13650]
CIM UP [12615, 12656, 12657, 12695]
AlertManager UP [12644, 12680, 12681, 12747]
Arithmos UP [12803, 12832, 12833, 12978]
SysStatCollector UP [12820, 12861, 12862, 13049]
Tunnel UP [12854, 12886, 12887]
ClusterHealth UP [12889, 12961, 12962, 13021, 13047, 13048, 13379, 13380]
Janus uP [12896, 12930, 1293 13274]
NutanixGuestTools UP [12921, 12976, 1297

Figure 10: Verifying that all cluster services are running properly on each node in the cluster.
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18. On the Windows 7 management system, enter the cluster IP address into the URL
bar, and press Enter.

19. Enter a password for the cluster admin account, and re-enter it. Click the arrow
button when finished.

m Nutanix Web Console x |+ o || &=

€ ) @ hitps://192168.0.100:9440/console/Zlogir e || Q searct wE U 3 A0 =

PRI

Create a new password for the cluster admin.

NUTANIXX

Figure 11: Providing an admin password for the Nutanix cluster.

20. Enter the admin credentials at the login prompt, and click the arrow button to log

in.
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y m MNutanix Web Console ®x |+ @Iﬂ“&l

€« a https://192.168.0.100:9440/ console/#page/dashboard [ Q, Search ﬁ' % 2 4+ # Q =
-
NutanixCluste L) N
Hypervisor Summary Cluster IOPS 010PS Health Critical Alerts
100 10PS
ESXi 6.0.0
HYPERVISOR VERSION cRmIca
pm 6:00pm 700pm AL
Storage Summary Cluster 10 Bandwidth 0 KBps Disks 18 ®0 0
You haven't set L
up your Hosts v @0 o E
storage. Would
ike 1o
Dpm 6:00pm F00pm
" VMs o @0 o
VM Summary Cluster Avg |0 Latency 0ms Data Reslliency Status warning Alerts
o
0 o
WVM(S) (1] VARNING
pm &:00pm T00pm
Data Resiliency possible
Hardware Summary Cluster CPU Cluster Info Alerts Events
Usage Memory
Usage W
© Rebuild capacity available
3 XC630-10 M= = 0 0o
HOSTS  BLOCKS MODEL OF 11515 GHz NFO EVENT -
. - o o -

Figure 12: The Nutanix Web Console dashboard page.

Configuring Nutanix storage
After creating the cluster, you must create a storage pool and a container. For
most organizations, it will be suitable to create a storage pool comprising all the physical
disks in the cluster and a container using all available capacity in the storage pool.

1. From the Nutanix Web Console main page, click the Home drop-down menu, and

select Storage.
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Figure 13: The Storage drop-down menu selection.

2. Click + Storage Pool in the upper-right corner. The Create Storage Pool dialog box

appears.
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Figure 14: The Nutanix Web Console Storage page.

3. Provide a name for the storage pool, and be sure that Use unallocated capacity is
checked, because that will be suitable for most environments.
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A storage pool is a group of physical disks from one or more tiers. Nutanix
recommends creating a single sterage pool to manage all physical disks within
the cluster.

NAME

StoragePool

CAPACITY

17.87 TiB Use unallocated capacity [@]

Figure 15: Creating a storage pool in the Nutanix Web Console.

4. Click Save.

5. Onthe Storage page, click + Container. The Create Container dialog box appears.

6. Provide a name for the container, check that the container will be created in the
intended storage pool, and verify that the NFS datastore will be mounted on all ESXi
hosts. Click Save.
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Enter a name for your container and select a storage pool for it. You can mount the
container as an NFS datastore for all hosts, or select individual hosts.

NAME

Contalner

STORAGE POOL

StoragePoal

MAX CAPACITY

1787 TiB

[Physical) Based on storage pool free unreserved capacity

NFS DATASTORE

® Mount onall ESXi hosts

QO Mount on the following ESXi hosts

-

% Advanced Settings Cancel

Figure 16: Creating a container in the Nutanix Web Console.

Configuring Dell XC630 hosts in vCenter

This guide assumes your environment has an existing deployment of VMware
vCenter Server. After creating the storage on the Nutanix cluster, add the Dell XC630
hosts to a vCenter for management. From there, configure their networking for
performance and security as per Nutanix best practices.

1. Ina browser, loginto the vSphere Web Client for the vCenter server.

2. Inthe Navigator pane, right-click the vCenter server, and select Add

Datacenter.

3. Provide a name for the Datacenter, and click OK.

In the Navigator pane, right-click the new Datacenter, and select New

Cluster...
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5. Provide a name for the cluster, and check the Turn ON boxes for DRS and

vSphere HA. Under DRS, make sure the Automation Level is set to Fully

automated.

%J New Cluster 2l
Name |Cluster-Nutanix |
Location Datacenter-Nutanix

~ DRS [] Turn oM
Automation Level [ Fulyautomated | - |
Migration Threshold Conservative ——"—— Aggressive

~ w3phere HA [w] Turn oM

Host Monitoring [] Enable host monitoring

« Admission Control

Admission Control Status Admission control will prevent powering on WMs that violate availahility
constraints

[w] Enable admission control

Policy Specify the type of the policy that admission control should enforce.

(=) Hostfailures cluster tolerates: |1 %'

(_) Percentage of cluster resources reserved as failover spare capacity.

~ VM Monitoring

VM Monitoring Status

| Disabled [~]

Overrides for individual VMs can be set from the VM Overrides page
from Manage Settings area.

Maonitaring Sensitivity Low ——" High
» EVC | Disable [~ ]
v Virtual SAN [ Turn on

oK || cancel \

Figure 17: Creating a new HA/DRS cluster in vCenter.

6. Inthe Navigator pane, select one of the Dell XC630 hosts, and click the
Manage tab.

7. Inthe Networking page, click VMkernel adapters, and click Add host
networking.
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Figure 18: The network management page for an XC30 host in the vSphere Web Client, with the default network
configuration.
8. Leave VMkernel Network Adapter selected, and click Next.
9. Inthe Select an existing standard switch field, click Browse, and select
vSwitchO. Click Next.
10. Provide a network label. We create one named vMotion-1if and another
named FaultTolerance-if for each host.
11. Set the appropriate VLAN ID for the type of traffic intended for this port. We
used VLAN 101 for vMotion, and VLAN 102 for Fault Tolerance.
12. Check the appropriate box for either vMotion traffic or Fault Tolerance

logging, and click Next.
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Figure 19: Enabling vMotion traffic and setting the appropriate VLAN ID on a new VMkernel port.

13.

14.
15.
16.
17.

18.
19.
20.

Set an appropriate static IP address, using separate subnets for vMotion and
Fault Tolerance. Click Next.

Click Finish.

Repeat steps 7 through 14 for the Fault Tolerance VMkernel port.

Repeat steps 6 through 15 for the two remaining Dell XC630 hosts.

Select the first Dell XC630 host in the navigator pane, and under its Manage
tab, click Networking.

In the Virtual switches section, select vSwitchNutanix, and click Edit.

Set the MTU to 9000, and click OK.

Repeat steps 18 and 19 for vSwitchO.
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Figure 20: Enabling jumbo frames (MTU 9000) on the Nutanix vSwitch.

21. Click VMkernel adapters, select the vMotion-if adapter, and click Edit.

22. In the NIC settings section, set the MTU to 9000, and click OK.

23. Repeat steps 21 and 22 for the FaultTolerance-if adapter and Vmk-svme-iscsi-
pg adapter.

24. In the Networking page, select vSwitch0, and click Edit.

25. Select the vmnic in the Standby adapters section, and click the up arrow
button to move it to the Active adapters section.

26. Click OK.

27. Repeat steps 17 through 26 for the remaining two Dell XC630 hosts.

28. Right-click the cluster in the Navigator pane and select Settings.

29. In the VM Overrides page, select each CVM and select Edit.

30. Set the vSphere HA Restart Policy to Disabled.

31. Set the Host Isolation Response for all CVMs to Leave Powered On.

32. Set the VM Monitoring for all CVMs to Disabled.

33. In the vSphere HA page, click Edit.

34. In the Datastore for Heartbeating section, Use datastores only from the

specified list, and select the Nutanix datastore.
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35. In the Advanced Options, click Add, and add an option named

das.ignoreInsufficientHbDatastore with avalue of true, and

click OK.
36. Select vSphere DRS, and set the DRS Automation Level to Manual.
37. Set the Power Management Automation Level to Off.

$t vSwitcho - Edit Settings

Properties Load balancing:

Security Metwork failure detection:

Traffic shapin
— Notify switches:

eaming and failover
Failback:

Failover order

Active adapters
vmnicO
vmnic

Standby adapters

Unused adapters

|' Route based on originating virtual port | - |

[ Link status only

|~)

| Yes

-]

| Yes

|'|

Select active and standby adapters. During a failover, standby adapters activate in the order specified above.

.

Figure 21: Setting both vmnic adapters to Active in the vSwitch0 NIC team in the vSphere Web Client.
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ABOUT THE TEST ENVIRONMENT

Figure 22 presents the test hardware we used, and Figure 23 provides

an overview of the VMs in our testing.

Hardware Quantity

Dell XC630-10 1U appliance 3

Dell Networking S4048-ON 10 Gigabit switch 2

Dell Networking N2024 Gigabit switch 2

Figure 22: Test hardware.

VM Application Role Host
SQL-1A SQL Server 2014 Database server 1
SQL-1B SQL Server 2014 Database server 1
sSQL-1C SQL Server 2014 Database server 1
SQL-2A SQL Server 2014 Database server 2
SQL-2B SQL Server 2014 Database server 2
sQL-2C SQL Server 2014 Database server 2
SQL-3A SQL Server 2014 Database server 3
SQL-3B SQL Server 2014 Database server 3
SQL-3C SQL Server 2014 Database server 3
CAS-1 Exchange Server 2013 Client access server 2
MBOX-1 Exchange Server 2013 Mailbox server 2
CAS-2 Exchange Server 2013 Client access server 3
MBOX-2 Exchange Server 2013 Mailbox server 3
lometer-1A lometer File/print workload 1
lometer-1B lometer Web server workload 1
lometer-2A lometer File/print workload 2
lometer-2B lometer Web server workload 2
lometer-3A lometer File/print workload 3
lometer-3B lometer Web server workload 3

Figure 23: VM overview.
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WORKLOADS

For the validation tests, we set up a mixed workload consisting of some
common business applications and simulated disk activity to run in concert over a 30-
minute period. We ran an OLTP database workload, a Microsoft Exchange workload, and

a simulated file/print server disk workload.

OLTP database workload: DVD Store
To simulate an OLTP workload, we used DVD Store 2.1, an open-source
application that models an online DVD store where customers log in, search for titles,
and purchase movies. We tested with Microsoft SQL Server 2014 as our database
server. Higher thread count and lower think times increase CPU utilization and IOPS. For
more information on DVD Store, please see

en.community.dell.com/techcenter/extras/w/wiki/dvd-store.aspx.

Testing parameters

e Database size: 4 GB
e Number of databases: one per VM
e Number of threads per VM: 60
e Actual test run time: 20 minutes
e Percentage of new customers: 20
e Number of line items: 4
e Think time: 0 seconds
e Warm-up time: 10 minutes
e Ramprate: 10
Additional VM parameters

e Each SQL VM was built with VHDXs for the OS, SQL Database, and SQL Logs
e Each SQL VM was configured as per best practices (E:\SQL Database, F:\SQL
Logs)
Output

e Orders per minute (OPM)

Exchange workload: Microsoft Load Generator 2013
The Microsoft Load Generator 2013 (LoadGen) benchmark performs tasks to
simulate a typical user generating mail activity on Microsoft Exchange Server 2013. We
divided our users into three mailbox databases, each with 80 users, for a total of 160
users/mailboxes. We ensured that performance was within acceptable RPC average
latency thresholds. For more information on Microsoft Load Generator 2013, please see

www.microsoft.com/en-in/download/details.aspx?id=40726.

Parameters

e Simulation: 8 hours
e Time: 30-minute duration
e 80 users per database (160 total)
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e Client: Outlook 2007 Cached

e Action profile: Outlook_50

e Mailbox profile: 2 MB
Output

e Success/failure
Disk activity workload: lometer
To simulate disk workloads for a file/print server and for a web server, we used
lometer, an application that allows various access specifications to be run against your
disk I/0 subsystem, including read/write percentages, sequential/random percentages,

and block sizes. For more information on lometer, please see www.iometer.org/.

Testing parameters for file/print server

o Test file size: 2 GB
e Number of outstanding I/Os: 1 per target
e Transfer request size: 512 KB
e Percentage Read/Write Distribution: 25% Write, 75% Read
e Percentage Random/Sequential Distribution: 100% Random
e Transfer delay: 70 ms
e Burstlength:11/0
e Actual test run time: 30 minutes
e Warm-up time: 1 minute
Testing parameters for web server

o Test file size: 2 GB
e Number of outstanding I/Os: 1 per target
e Transfer request size: 512 B
e Percentage Read/Write Distribution: 5% Write, 95% Read
e Percentage Random/Sequential Distribution: 100% Random
e Transfer delay: 2 ms
e Burstlength:11/0
e Actual test run time: 30 minutes
e Warm-up time: 1 minute
Additional VM parameters

e Each test file took up the entirety of a 2GB VHDX, on a separate volume
from the OS
Output

e Latency, IOPS, MBps
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VALIDATION AND TEST RESULTS

Nutanix storage cluster on Dell XC630 supporting all application workloads
e SQL/OLTP: 9 instances of SQL 2014 databases (3 per host) — ~420,000 OPM
e LoadGen/Exchange profile: Outlook 50 — 160 mailboxes
e lometer — File/print workload

e |lometer — Web server workload

Our validation test showed that running nine SQL Server 2014 workloads with
DVD Store, two Microsoft Exchange Server 2013 environments, and six disk workloads
could be readily handled by a three-node cluster of Dell XC630 appliances backed by
Nutanix tiered storage. Median CPU usage on each host was 44.7 percent, so your
business would have room to grow from the configuration validated here (see Figure
24). Storage response time stayed low (3.7 milliseconds median) over the course of the
test, with some variability on node 1, which wasn’t housing an Exchange environment
(see Figure 25). Over the course of the test, the hosts’ disks put out a median of 1,089
IOPS per host, with node 1 delivering higher but more variable I0PS performance (see
Figure 26).

Percentage processor time
70
60
50
40

Node 1
30

Percentage

= Node 2

20 = Node 3

10

0 2 4 6 7 9 11 13 15 17 18 20 22 24 26 28 29

Minutes

Figure 24: Percentage of processor time used by each Dell XC630 host over the test run.
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Average disk latency (ms)
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Figure 25: Average disk latency for each Dell XC630 host’s disks.
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Figure 26: Total disk IOPS performed for each Dell XC630 host’s disks.
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SUMMARY

If your business is considering using a hyperconverged
computer/storage solution rather than disparate dedicated appliances, a
Nutanix storage cluster powered by Dell XC630 appliances could bring many
benefits. Thanks to its powerful Dell servers with Intel processors, this space-
efficient solution was able to handle nine SQL Server 2014 OLTP workloads at
over 420,000 OPM, 160 mailboxes in Microsoft Exchange 2013, and file/print
and web server disk workloads; that’s enough to meet your present demands
and still have room for future growth. With software-defined tiered storage,
high availability, and a redundant network architecture, the hyperconverged
solution based on Dell XC630 appliances can help your business get the job
done.
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APPENDIX A — DETAILED SYSTEM CONFIGURATION

Figure 27 shows the configuration details of the test system.

System | Dell XC630-10
Power supplies

Total number 2

Vendor and model number Dell OTFR9VAO01

Wattage of each (W) 1100

General

Number of processor packages 2

Number of cores per processor 8

Number of hardware threads per core 2

System power management policy

Performance Per Watt (OS)

CPU

Vendor Intel

Name Xeon

Model number E5-2630v3
Socket type FCLGA2011-3
Core frequency (GHz) 2.4

Bus frequency 8 GT/s

L1 cache 32 + 32 KB (per core)
L2 cache 256 KB (per core)
L3 cache 20 MB

Platform

Vendor and model number Dell XC630-10
Motherboard model number OCNCIW

BIOS name and version 1.3.6

BIOS settings Defaults

Memory module(s)

Total RAM in system (GB) 192

Vendor and model number Micron® 36ASF2G72PZ-2G1A2
Type PC4-2133

Speed (MHz) 1,866

Speed running in the system (MHz) 1,866

Size (GB) 16

Number of RAM module(s) 12

Chip organization Double-sided

Rank 2Rx4

Operating system

Name VMware ESXi 6.0.0
Build number 3029578
Language English
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System

Dell XC630-10

RAID controller

Vendor and model number

PERC H730 Mini

Firmware version 25.3.0.0016
Cache size (GB) 1
RAID configuration None

Hard disk types

SSDs

Vendor and model number

Intel SSDSC2BA200G3R

Number of disks 2

Size (GB) 200

RPM N/A

Type SATA 6 Gbps

HDDs

Vendor and model number Seagate® ST91000640SS
Number of disks 7

Size (GB) 1,000

RPM 7,200

Type SATA 6 Gbps

Ethernet adapters

Vendor and model number Intel 4-port X520/1350 rNDC
Firmware 15.0.28

Type On-board

USB ports

Number 2

Type USB 2.0

Figure 27: Configuration specifications of our test system.
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APPENDIX B — DETAILED CONFIGURATION METHODOLOGY
Configuring application VMs

In this section, we walk through how to configure the applications we tested. We created and configured VMs
for Exchange Server 2013, SQL Server 2014, and lometer for ESXi via the vSphere Web Client. The Exchange CAS VMs
were configured with two vCPUs and 16 GB of RAM, and the Exchange Mailbox VMs were configured with four vCPUs
and 16 GB of RAM. Each SQL Server 2014 VM was configured with four vCPUs and 8 GB of RAM, and each lometer VM
was configured with one vCPU and 4 GB of RAM.

Creating VMs for ESXi in the vSphere Web Client

We used the vSphere Web Client to create the VMs for our application environments. Here we walk through
creating a sample VM, providing generic details about the virtual hardware, which can be customized as necessary. We
created the VMs on the host we wanted them to reside on, though the host for each VM can be changed after creation.

1. Loginto the vSphere Web Client in a browser with administrator credentials.

2. Right-click the host on which you want to create the new VM, and select New Virtual Machine—>New
Virtual Machine...

Select Create a new virtual machine, and click Next.

Enter a name for the virtual machine, and click Next.

Select the desired host as a compute resource, and click Next.

Select the Nutanix storage cluster’s NFS container as the storage for the VM, and click Next.

Click Next.

Select an appropriate Guest OS Family and Version, and click Next.

W o N U; W

At the Customize hardware screen, set the number of vCPUs, the amount of RAM, and the size and
number of hard disks and their SCSI controllers. In addition, provide installation media to the VM, and
click Next.

10. Review the selected settings, and click Finish.

Configuring Microsoft Exchange 2013 for Load Generator 2013
Preparing AD for Exchange

Perform the following steps once on your infrastructure’s Active Directory server.

1. Insert the Exchange 2012 SP1 Installation ISO in the AD VM DVD drive.
In Windows Explorer, double-click the Exchange DVD icon.
In the Exchange installation folder, hold down shift, and right-click.

Choose Open a command window here.

vk W

Run the following command: Setup.exe /PrepareSchema
/IAcceptExchangeServerLicenseTerms

6. When the previous command completes, run the following command: Setup.exe /PrepareAD
/OrganizationName:”organization name”
/IAcceptExchangeServerLicenseTermnms

7. Close the command window when the setup finishes.
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Installing Active Directory Certificate Services
1. Launch Server Manager, and select Add roles and features.
At the Add Roles and Features Wizard, click Next.
Select Role-based or feature-based installation, and click Next.
Choose Active Directory Certificate Services.
Click Add Features, if prompted, to install any required features.
Click Next.
Click Next.
Click Next.
Choose Certificate Authority and Certification Authority Web Enrollment.

L N R WD
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. Click Add Features, if prompted, to install any required features.
. Click Next.

. Leave defaults, and click Next.

. Click Install.

. Click Close when the install finishes.

[ e S S =Y
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. Click on the yellow warning symbol in the Server Manager, and click Configure Active Directory
Certificate Services.

16. Leave defaults, and click Next.

17. Check both Certification Authority and Certification Authority Web Enrollment, and click Next.

18. Choose Enterprise CA, and click Next.

19. Choose Root CA, and click Next.

20. Choose Create a new private key, and click Next.

21. Leave defaults, and click Next.

22. Leave defaults, and click Next.

23. Leave 5 years, and click Next.

24. Leave default locations, and click Next.

25. Click Configure.

26. Close when the configuration finishes.

27. Open Internet Explorer® and navigate to localhost/certsrv/Default.asp to verify that the installation

succeeded.

Installing Exchange Server 2013 SP1 Mailbox and Client Access Server roles

We created two VMs each to serve as Mailbox and CAS servers for our Exchange environments and edited the
hardware settings in each. The Mailbox servers had four vCPUs and 16 GB of memory, and the CAS servers had two
vCPUs and 16 GB of memory. We also provided the Mailbox VMs with a 200GB data disk and a 200GB logs disk each for
Exchange’s database and logs, respectively. We gave each CAS VM a 100GB disk onto which we would install Exchange.
We set static IPs on all the VMs and joined the domain. We ran the following commands on both Mailbox VMs and both
CAS VM s as appropriate. By the end of these steps, we had two functional and separate Exchange Server setups, sharing
an Active Directory.
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1. On each Mailbox and CAS server, log into the server using domain administrator credentials.

2. Open Windows PowerShell and run the following command:

Install-WindowsFeature AS-HTTP-Activation, Desktop-Experience, NET-
Framework-45-Features, RPC-over-HTTP-proxy, RSAT-Clustering, RSAT-
Clustering-CmdInterface, RSAT-Clustering-Mgmt, RSAT-Clustering-
PowerShell, Web-Mgmt-Console, WAS-Process-Model, Web-Asp-Netd5, Web-
Basic-Auth, Web-Client-Auth, Web-Digest-Auth, Web-Dir-Browsing, Web-Dyn-
Compression, Web-Http-Errors, Web-Http-Logging, Web-Http-Redirect, Web-
Http-Tracing, Web-ISAPI-Ext, Web-ISAPI-Filter, Web-Lgcy-Mgmt-Console,
Web-Metabase, Web-Mgmt-Console, Web-Mgmt-Service, Web-Net-Ext45, Web-
Request-Monitor, Web-Server, Web-Stat-Compression, Web-Static-Content,
Web-Windows—-Auth, Web-WMI, Windows-Identity-Foundation

3. Restart the server.
Download the Microsoft Unified Communications Managed API 4.0, Core Runtime 64-bit.
(go.microsoft.com/fwlink/p/?linkld=258269)

Run UcmaRuntimeSetup.exe.

When the installation completes, click Finish.

Navigate to the location of the Exchange installation media, and double-click Setup.exe.

o N o w

At the Check for Updates? screen, check the Connect to the Internet and check for updates checkbox, and
click Next.
9. When the updates complete, click Next.
10. At the Introduction screen, click Next.
11. At the License Agreement screen, check the box to accept the terms, and click Next.
12. At the Recommended Settings screen, check the Don’t use recommended settings checkbox, and click Next.
13. At the Server Role Selection, select Mailbox or Client Access role as appropriate, and click Next.
14. At the Installation Space and Location screen, provide an appropriate location for the installation, and click
Next.
15. At the Malware Protection Settings, select yes to disable, and click Next.
16. At the Readiness Checks screen, allow the verification to complete. If there are no failures, click Install.
17. When the installation completes, click Finish, and restart the server.
18. Repeat steps 1 through 17 for the remaining Exchange VMs.
Configuring Exchange
1. On the CAS server, open the Exchange Admin Center by using a browser and navigating to
https://localhost/ecp
Enter the domain administrator credentials, and click Sign in.
If prompted, select the language and time zone, and click Save.

In the left pane, click Mail flow, and click Send connectors.

vk W

On the Send connectors page, click the New icon.
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In the new Send connectors wizard, specify an appropriate name and select Internet as the type. Click Next.
In the Network settings screen, choose MX record associated with recipient domain, and click Next.
In the Address space screen, click Add.

L LN

In the Add domain window, enter the desired address space in the Fully Qualified Domain Name (FQDN)

field, and click Save.

10. Click Next.

11. In Source server screen, click Add.

12. In the Select a Server window, select the mailbox server, click Add, and click OK.

13. Click Finish.

14. In the left pane of the EAC, click servers, select the name of the CAS server, and click Edit.

15. Click Outlook Anywhere, and enter the appropriate FQDN of the Client Access Server for the external and
internal hostname field. For example, exchangeserver.test.local.

16. Choose NTLM as the authentication method, and click Save.

17. Click Virtual Directories, and click the Configure external access domain icon.

18. In the Select the Client Access servers to use with the external URL window, click Add.

19. Select the CAS server, and click Add. Click OK.

20. In the Enter the domain field, enter the FQDN of the CAS server, and click Save.

21. Log into the Active Directory server using administrator credentials, and complete the following steps:

a. Open Server Manager, and click Tools=>DNS.

b. In DNS Manager, expand the Active Directory server name—>Forward Lookup Zones—>test.local in
the left pane.

C. Inthe right pane, verify or create the DNS records as presented in Figure 28.

Type Ho.st or.child FQDN FQDN of mail
domain/alias name server

Mail Exchanger (MX) | Leave blank domain.com casserver.domain.com

Alias (CNAME) Autodiscover Autodiscover.domain.com | casserver.domain.com

Alias (CNAME) Owa Owa.domain.com casserver.domain.com

Figure 28: DNS records.

22. Log back into your CAS server.
23. In the Exchange PowerShell, run the following commands, replacing “SHostName” with the host name (not
FQDN) of your CAS server.

Set-EcpVirtualDirectory "S$SHostName\ECP (Default Web Site)" -InternalUrl
((Get-EcpVirtualDirectory "S$HostName\ECP (Default Web
Site)") .ExternalUrl)

Set-WebServicesVirtualDirectory "S$HostName\EWS (Default Web Site)" -
InternalUrl ((get-WebServicesVirtualDirectory "S$HostName\EWS (Default Web
Site)") .ExternalUrl)
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Set-ActiveSyncVirtualDirectory "S$SHostName\Microsoft-Server-ActiveSync
(Default Web Site)" -InternalUrl ((Get-ActiveSyncVirtualDirectory
"SHostName\Microsoft-Server-ActiveSync (Default Web Site)") .ExternalUrl)

Set-OabVirtualDirectory "S$HostName\OAB (Default Web Site)" -InternalUrl
((Get-OabVirtualDirectory "S$HostName\OAB (Default Web
Site)") .ExternalUrl)

Set-OwaVirtualDirectory "SHostName\OWA (Default Web Site)" -InternalUrl
((Get-OwaVirtualDirectory "SHostName\OWA (Default Web
Site)") .ExternalUrl)

Set—-PowerShellVirtualDirectory "S$SHostName\PowerShell (Default Web Site)"
-InternalUrl ((Get-PowerShellVirtualDirectory "S$HostName\PowerShell
(Default Web Site)") .ExternalUrl)

Get-0OfflineAddressBook | Set-OfflineAddressBook -
GlobalWebDistributionEnabled $True -VirtualDirectories $Null

24. Create a folder at the root of C: on the CAS server, and share it to Everyone with read/write permissions.

25. Log back into the Exchange admin center, and navigate to Servers—>certificates.

26. Choose the CAS server in the drop-down menu, and click the plus sign to create a new certificate.

27. Choose Create a request for a certificate from a certification authority, and click Next.

28. Name the certificate, and click Next.

29. Do not request a wildcard certificate, and click Next.

30. Click Browse, choose the CAS server, and click OK. Click Next.

31. Leave defaults, and click Next.

32. Leave defaults, and click Next.

33. Enter your organization information, and click Next.

34. Enter the path to the share you created on the CAS server, and click Finish. Example:
\\cas\share\myrequest.REQ

35. Log into the AD server, and open Internet Explorer.

36. Browse to localhost/CertSrv

37. Click Request a certificate.

38. Choose advanced certificate request.

39. Choose Submit a certificate request by using a base-64-endcoded CMC...
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40. Open Windows Explorer and navigate to the share folder on the CAS server where the certificate request is
stored.

41. Open the certificate with notepad, and copy the content between BEGIN NEW CERTIFICATE REQUEST and
END NEW CERTIFICATE REQUEST.

42. Paste the copied content into the Saved Request window.

43. Choose Web Server in the Certificate Template drop-down menu, and click Submit.

44. Choose Base 64 encoded, and download the certificate.

45. Copy the new certificate into the share folder on the CAS server.

46. Log back into the CAS server and open the Exchange Admin Center.

47. Go to Servers—>Certificates, and highlight the certificate you began before (should say Pending request in
the status column).

48. Click Complete on the right side.

49. Type the path to the certificate, including the certificate name, and click OK. Example:
\\cas\share\certnew.CER

50. Verify that the status has changed to Valid.

51. Edit the new entry, and click Edit.

52. Go to services and check SMTP and IIS, click Save.

53. On the warning message, click Yes.

54. Perform the following steps on the CAS and AD servers:

Click Start, and type MMC

Click File>Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates>Trusted Root Certificate Authorities=> Certificates.

Click Action>All Tasks—=> Import.

Click Next.

j. Browse to the share folder on the CAS server, and choose the new certificate you created. Click
Next.

k. Leave defaults, and click Next.

I.  Click Finish.

m. On the Import was successful message, click OK.

Sm 0 a0 T

55. Log into the CAS server, and open the Exchange admin center.

56. Navigate to Servers—>Databases.

57. Restart the Microsoft Exchange Information Store service on the MB server.

58. Click Edit, and disable the maintenance schedule and enable circular logging for each mailbox database.
59. Dismount and remount the databases.

60. Open Exchange Management shell, and enter the following to move the paths of the default mailbox:
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61.
62.

Move-Databasepath “DatabaseName” -EdbFilepath “E:\Newlocation\DBname.edb”
-LogFolderpath “F:\Newlocation”

When prompted, type A and press Enter.

Open Exchange Management Shell, and enter the following:

Get-OutlookAnywhere |Set-OutlookAnywhere -ExternalHostname cas.domain.com
-DefaultAuthenticationMethod NTLM -ExternalClientsRequireSsl S$true

Installing and configuring the Exchange 2013 mail test clients and completing LoadGen
configuration on the Exchange Server 2013

For our testing, we used one virtual client machine to run each instance of Load Generator 2013. To create the

mail clients, we installed several software components. We followed this process for each installation:

Installing Windows Server 2008 R2 SP1 Enterprise Edition

1.
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Insert the installation DVD for Windows Server® 2008 R2 SP1 Enterprise into the DVD drive.

At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Click the | accept the license terms checkbox, and click Next.

Click Custom.

Click Next.

At the User’s password must be changed before logging on warning screen, click OK.

Enter the desired password for the administrator in both fields, and click the arrow to continue.

. At the Your password has been changed screen, click OK.

. Click Start, type change power-saving settings and press Enter.
. Click Change plan settings.

. Change the Turn off the display drop-down menu to Never.

14.

Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization screens.

To set up this server, we had to install several additional software components. The following subsections detail

the necessary installation processes.

Joining the domain

1.
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Set a static IP.

Select Start->Control Panel>Network Connections—>Local Area Connection.

Click Properties.

Highlight Internet Protocol (TCP/IP), and click Properties.

Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the
Preferred DNS server field. Click OK.

Right-click My Computer, and select Properties.

Under the Computer Name tab, click Change.

In the Computer Name Changes screen, under the Member of section, select the Domain radial box, and
type test.local.

Select OK to start joining the domain.
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10. When the screen appears asking for a person qualified on the domain, type Administrator as the
username and Passwordl as the password.

11. At the Welcome pop-up window and the window warning that you must reset the computer for the changes
to take effect, click OK.

12. At the System Properties screen, click OK.

13. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services

1. Click Start>Administrative Tools—> Server Manager.
In the left pane, click Roles.
Click Add Roles.
Click the Application Server checkbox.
When the Add features required for Application Server? screen appears, click Add Required Features.
Click Next.
Click Next.
At the Select Role Services page for Application Server, click the Web Server (11S) Support checkbox.
Click Add Required Support Role Services.

. Click Next.

. Click Next.

. At the Select Role Services page for Web Server (11S), click IIS 6 Management Compatibility, ASP, and CGl
checkboxes; then, click Next.

13. Click Install.

14. Click Close.
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Installing Load Generator

Download and install Load Generator 2013 using all defaults.

Importing the certificate and editing the hosts file

1. Click Start, and type MMC.

2. Click File=>Add/Remove Snap-in.

3. Choose Certificates, and click Add.

4. Choose Computer account, and click Next.

5. Choose Local computer, and click Finish.

6. Click OK.

7. Expand Certificates> Trusted Root Certificate Authorities—> Certificates.
8. Click Action>All Tasks—=>Import.

9. Click Next.

10. Browse to the share folder on the CAS server, and choose the new certificate you created. Click Next.
11. Leave defaults, and click Next.

12. Click Finish.

13. On the Import was successful message, click OK.
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14.

15.
16.

Open the Notepad program, and use File=>Open to open the hosts file stored at
C:\Windows\System32\drivers\etc.

Add the IP address and FQDN of the CAS server.

Save and close Notepad.

Preparing Load Generator

1.
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10.

11.
12.
13.
14.

Log into the mail client.

Select Start=>All Programs—>Microsoft Exchange—> Exchange Load Generator 2013.

When the Load Generator screen appears, select Start a new test.

Select Create a new test configuration, and click Continue.

Change the total length of simulation to 1 hour.

In the Specify test settings screen, type Password]l as the Directory Access Password and Mailbox Account
Master Password, and click Continue with recipient management.

Create 750 users in the Mailbox Database, and click Continue.

To accept defaults for Advanced recipient settings, click Continue.

In the Specify test user groups screen, select the plus sign to add a user group.

Change the Client Type to Outlook 2007 Cached, the action profile to Outlook_200, and the Mailbox size to
250 MB, and click Continue.

In Remote configurations, click Continue.

Click Save the configuration file as, and name it testcfg.xml

Click Start the initialization phase (recommended before running the test).

Once you have initialized the database, create a backup copy of the Exchange mailbox databases.

Installing and configuring lometer

1.
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10.
11.
12.

On the lometer VMs, open a web browser, and navigate to sourceforge.net/projects/lometer/files/lometer-
stable/1.1.0/lometer-1.1.0-win64.x86 64-bin.zip/download.
Run the installer wizard with defaults.

Launch lometer.

In the Topology pane, click the manager with the VM’s host name.

In the Disk Targets tab, check the box next to the empty disk to be used for testing.

In the Access Specifications tab, click New.

Select the new specification, and click Edit.

Set the parameters based on the workload you want to test.

Click OK.

Click Add.

In the Test Setup tab, enter the run time details, and provide a description for the test.

When ready to test, click the green flag button, and provide an output file path.

Dell XC630-10 Nutanix on VMware ESXi reference architecture A Principled Technologies reference architecture 44


http://sourceforge.net/projects/iometer/files/iometer-stable/1.1.0/iometer-1.1.0-win64.x86_64-bin.zip/download
http://sourceforge.net/projects/iometer/files/iometer-stable/1.1.0/iometer-1.1.0-win64.x86_64-bin.zip/download

Installing Microsoft SQL Server 2014

1.
2.

10.

11.
12.

13.
14.
15.
16.

17.
18.
19.
20.
21.
22.
23.

24.
25.
26.

Insert the installation DVD for SQL Server 2014 into the DVD drive.

Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2014 DVD, and
double-click.

If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core
role.

In the left pane, click Installation.

Click New installation or add features to an existing installation.

At the Setup Support Rules screen, wait for the check to complete. If there are no failures or relevant
warnings, click OK.

Select the Evaluation edition, and click Next.

Click the checkbox to accept the license terms, and click Next.

Click Install to install the setup support files.

If no failures are displayed, click Next. You may see a Computer domain controller warning and a Windows
Firewall warning. For now, ignore these.

At the Setup Role screen, choose SQL Server Feature Installation.

At the Feature Selection screen, select Database Engine Services, Full-Text Search, Client Tools Connectivity,
Client Tools Backwards Compatibility, Management Tools — Basic, and Management Tools — Complete. Click
Next.

At the Installation Rules screen, once the check completes, click Next.

At the Instance configuration screen, leave the default selection of default instance, and click Next.

At the Disk space requirements screen, click Next.

At the Server configuration screen, choose NT Service\SQLSERVERAGENT for SQL Server Agent, and choose
NT Service\MSSQLSERVER for SQL Server Database Engine. Change the SQL Server Agent Startup Type to
Automatic. Click Next.

On the Data Directories tab, enter the SQL Server directories of the data and logs volumes created earlier.
At the Database Engine Configuration screen, select Mixed Mode.

Enter and confirm a password for the system administrator account.

Click Add Current user. This may take several seconds.

Click Next.

At the Error and usage reporting screen, click Next.

At the Installation Configuration rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Close.

Download and install Cumulative Update 6 for SQL Server 2014 at support.microsoft.com/en-

us/kb/3031047.
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Configuring the database workload client
For our testing, we used a virtual client for the Microsoft SQL Server client. To create this client, we installed
Windows Server 2008 R2, assigned a static IP address, and installed .NET 3.5.

Configuring the database

We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the
parameters for our 4GB database size and the database platform on which we ran, Microsoft SQL Server 2014. We ran
the Install.pl script on a utility system running Linux®. The database schema was also generated by the Install.pl script.

After processing the data generation, we transferred the data files and schema creation files to a Windows-
based system running SQL Server 2014. We built the database in SQL Server 2014, and performed a full backup, storing
the backup file on the C: drive for quick access. We used that backup file to restore the server between test runs.

The only modification we made to the schema creation scripts were the specified file sizes for our database. We
deliberately set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the
test. Besides this file size modification, the database schema was created and loaded according to the DVD Store
documentation. Specifically, we performed the following steps:

1. We generated the data and created the database and file structure using database creation scripts in the
DS2 download. We made size modifications specific to our database and the appropriate changes to drive
letters.

We transferred the files from our Linux data generation system to a Windows system running SQL Server.
We created database tables, stored procedures, and objects using the provided DVD Store scripts.

We set the database recovery model to bulk-logged to prevent excess logging.
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We loaded the data we generated into the database. For data loading, we used the import wizard in SQL
Server Management Studio. Where necessary, we retained options from the original scripts, such as Enable
Identity Insert.
We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
We updated statistics on each table according to database-creation scripts, which sample 18 percent of the
table data.
8. Onthe SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL)
script:
USE [master]
GO
CREATE LOGIN [ds2user] WITH PASSWORD=N'"',

DEFAULT DATABASE= [master],

DEFAULT LANGUAGE= [us_english] ’

CHECK EXPIRATION=OFF,

CHECK POLICY=OFF
GO
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9. We set the database recovery model back to full.

10. We created the necessary full text index using SQL Server Management Studio.

11. We created a database user and mapped this user to the SQL Server login.

12. We performed a full backup of the database. This backup allowed us to restore the databases to a pristine
state relatively quickly between tests.

Running the test
Test start and run times

We ran the workloads with one client per target database. The specific testing parameters we used for the

benchmark are included below.
Running the DVD Store tests

We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store
outputs an orders-per-minute metric, which is a running average calculated through the test. In this report, we report
the aggregate OPM reported by the clients for each run.

Each complete test cycle consisted of the general steps listed below.

Clean up prior outputs from the target system and the client driver system.
Drop the database from the target servers.

Restore the database on the target servers.

Shut down the target.

Reboot the host and client systems.

o Uk wnNRE

Wait for a ping response from the server under test (the hypervisor system), the client system, and the
target.

Let the test server idle for 10 minutes.

Start the DVD Store driver on each client.

® N

We used the following DVD Store parameters for testing:

dsZ2sglserverdriver.exe --target=<target IP> --ramp rate=10 --run time=20
-—n_threads=64 --db size=4GB --think time=0 --detailed view=Y --
warmup time=10 --csv output=<drive path>
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APPENDIX C— CONFIGURING THE S4048-ON SWITCH

Version 9.8 (0.0P5)

|
! Last configuration change at Sat Sep 22 06:03:25 2015 by admin
! Startup-config last updated at Sat Sep 22 05:38:40 2015 by default

|
boot system stack-unit 1 primary system: A:

boot system stack-unit 1 secondary system: B:

redundancy auto-synchronize full
|

hostname Switch-A
|

default-vlan disable
|
protocol spanning-tree rstp
no disable
bridge-priority O
|
vlt domain 100
peer-link port-channel 100
back-up destination 192.168.0.82
|

stack-unit 1 provision S4048-ON
|
interface TenGigabitEthernet 1/1
description "uplink to N2024 switch"
no ip address
mtu 12000
speed 1000
|
port-channel-protocol LACP
port-channel 111 mode active
dampening 10 100 1000 60
no shutdown
|
interface TenGigabitEthernet 1/2
description "XC-node-la"
no ip address
mtu 12000
portmode hybrid
switchport

no shutdown
|

interface TenGigabitEthernet 1/3
description "XC-node-2a"

no ip address

mtu 12000

portmode hybrid
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switchport
no shutdown
|
interface TenGigabitEthernet 1/4
description "XC-node-3a"
no ip address
mtu 12000
portmode hybrid
switchport
no shutdown
|
!
interface fortyGigE 1/49
description VLT-peerlink
no ip address
no shutdown
|
interface fortyGigE 1/50
description VLT-peerlink
no ip address
no shutdown
|
interface ManagementEthernet 1/1
ip address 192.168.0.81/23
no shutdown
|
interface Port-channel 100
description "VLTi - interconnect link"
no ip address
channel-member fortyGigE 1/49,1/50
no shutdown
|
interface Port-channel 111
description lacp to dell tor
no ip address
mtu 12000
switchport
vlit-peer-lag port-channel 100
no shutdown
|
interface Vlan 1
|
interface Vlan 10
description public-net
no ip address
tagged TenGigabitEthernet 1/2-1/13
tagged fortyGigE 1/51
tagged Port-channel 100,111
no shutdown
|
interface Vlan 100
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description priv-net
no ip address

mtu 12000

tagged fortyGigEkE 1/51

tagged Port-channel 100,111

untagged TenGigabitEthernet 1/2-1/13
no shutdown

interface Vlan 101
description vMotion-net
no ip address

mtu 12000

tagged TenGigabitEthernet 1/2-1/13
tagged Port-channel 111
no shutdown

interface Vlan 102
description FT-net
no ip address

mtu 12000

tagged TenGigabitEthernet 1/2-1/13
tagged Port-channel 111
no shutdown

ip ssh server enable

protocol 1lldp

advertise management-tlv system-description system-name

!
line
line
line
line
line
line
line
line
line
line
line
|

reload-type
boot-type normal-reload
config-scr-download enable

end

console 0

vty
vty
vty
vty
vty
vty
vty
vty
vty
vty

0

O o0 Joy W
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